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1.0 Software Installation 

1.1 Introduction  

SpeedCheck Manager is designed for use with SpeedCheck devices manufactured after January of 2002. Field 

upgrades are available for all units manufactured before that date. The latest version of the software can be found 

here: support.carmanah.com. Navigate to the software section and fill out the form to download the software. The 

software can is also included with the install / Bluetooth dongle programming kit. 

Note before installing - previous DeviceManager or DisplayManager users: the installer will preserve your 

previous data files and Scheduler settings. The installer will prompt you to make a backup copy of your files if you 

so desire. All files in the My Documents\SpeedCheck folder will be moved to the new directory location of:  

• Windows 7, 10 & 11 – C:\Users\Public\Documents\Carmanah Technologies\SpeedCheck Manager\Data 

Files 

The legacy Excel based TrafficAnalyzer has been replaced with a version which does not require Excel, known as 

SpeedCheck Traffic Analyzer. The legacy data has been saved in the Data Files folder in a folder named “Old 

Data Files”. SpeedCheck Manager / Traffic Analyzer must be installed with administrative privileges (right click the 

installer and click “run as administrator”). 

SpeedCheck Manager/Traffic Analyzer Overview  

SpeedCheck Manager – runs on a personal computer (PC) enabling the user to set up the various functions of 

the SpeedCheck display or flasher including event scheduling and downloading vehicle speed data. This software 

was previously known as DisplayManager or DeviceManager. 

 

SpeedCheck Traffic Analyzer – runs on a PC enabling the user to process the raw data and provide visual aids 

for analysis of the traffic speed data gathered by the SpeedCheck display. This software was previously known as 

TrafficAnalyzer. 

 

Note: Using a Palm device to program and download data: The Palm E2 and TX are not compatible with the latest 

firmware and software. Palm is no longer selling new PDA devices and is no longer support by Carmanah. 

System Requirements 

• PC running Windows 7 or later  

• Microsoft .NET 4.5.2 or newer. The latest version of .NET can be found here: 

https://dotnet.microsoft.com/download/dotnet-framework 

 

1.2 Installation and Configuration 

1. The installer must have Administration rights to move forward with the installation. 

2. Confirm you have the USB flash drive or digital download of the software. 

3. Run the installer executable and follow the prompts on the screen to complete the installation. 

4. Confirm you now have desktop icons for SpeedCheck Manager and SpeedCheck Traffic Analyzer. 

 

mailto:customersupport@carmanah.com
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2.0 SpeedCheck Manager (PC) 

2.1 Communication 

The SpeedCheck Manager application provides communication between a Windows-based PC and SpeedCheck 

radar feedback/advisory signs and flashers. 

SpeedCheck Manager is designed to communicate directly with a sign or flasher via Bluetooth, direct serial 

connection (Cable), or remotely via cellular (Network). 

• A USB Bluetooth dongle is shipped with each order, which is to be used for PCs that do not have native 

Bluetooth radio. Some native Bluetooth modules may not be compatible with SpeedCheck Manager – in 

these instances use a USB Bluetooth dongle. See Section 5.0. 

• Serial connections require that your PC has a RS-232 serial port available. Alternatively, a serial-to-USB 

adapter can be used instead. The serial connection requires a custom cable that is installed into the 

SpeedCheck controller located inside the system. 

 

2.2 Operation 

SpeedCheck Manager allows the setting of communication and operation parameters of the SpeedCheck system. 

There are six basic steps in using SpeedCheck Manager: 

1. Select the communication method (Bluetooth, Cable, Network). 

2. Establish a connection with the system. 

3. Set the system’s internal clock/calendar and provide an alphanumeric name for the system (Set Time & 

ID). 

4. Select whether one set or two sets of speed settings will be used, or if the Scheduler is to be used 

(Device Setup/Operating Modes/Scheduler). 

5. Enter the desired parameters under Operating Modes/Scheduler based on step 4. 

6. Apply the settings to program the sign. 
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2.3 System Tab 

Upon starting SpeedCheck Manager the software will show the System tab below: 

 

You will note that several tabs are displayed which allow setting of various options. Which tabs show will be 

based on system configuration: 

• Scheduler only shows when selected as an operating mode under Device Setup, if enabled at the factory 

by Carmanah. 

• Data Collection only shows if enabled at the factory by Carmanah. 

Both Scheduler and Data Collection were optional add-ons previously and are now shipped as standard features 

by Carmanah starting in 2020 Q1. 

The Scheduler tab allows for creating and editing schedules without being connected to a system. Schedules can 

then be sent to the system once a connection is established. 

All other tabs require a connection to be established before changes can be made. 

Refresh Information From Device 

Refreshes the screen for any updates to the currently connected system. 
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Currently Connected Device 

Provides a snapshot of the settings from the currently connected system. 

 

Software Version 

The version number of SpeedCheck Manager can be found by click on Help → About SpeedCheck Manager. 

 

2.4 Communications 

A communications method must be chosen before establishing a connection. Each communication method 

requires its own unique hardware setup. 

• Bluetooth – Local wireless connectivity; requires a PC with internal or external Bluetooth capabilities. You 

must be within range (less than 100 feet, and the closer the better) of the system to send and receive 

data when using Bluetooth. 

• Cable – Local wired connectivity; requires an RS-232 serial port connection or serial-to-USB adapter. A 

custom cable from Carmanah is also required to connect to the system. 

• Network – Remote wireless connectivity; requires each system to have the following: 

o Cellular connectivity configured with an active cellular modem 

o Ethernet connectivity configured with a serial-to-Ethernet converter 

▪ See support.carmanah.com for documentation on Ethernet connectivity 

o Internet access to connect to the system via a PC 

mailto:customersupport@carmanah.com
https://www.carmanah.com/
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Bluetooth Connection Setup 

The Bluetooth option allows you to scan for the system and connect to via the Establish Connection button. 

SpeedCheck systems by default will appear as “SpeedCheck######” to distinguish from other Bluetooth enabled 

devices. 

1. Insert the USB Bluetooth dongle into your PC (as required) or ensure the integrated Bluetooth is enabled. 

2. Open SpeedCheck Manager. 

3. Click on the Onsight/Bluetooth radio button, if it is not already selected. 

4. Click on Establish Connection. 

5. Bluetooth devices within range will appear in the window. Choose the correct system and click Connect.  

a. If you don’t know which system you are connected to, click on Run Test Sequence afterwards 

and look at the display LEDs to verify (if applicable). SpeedCheck Manager should now reflect 

that it is connected to the system. 

b. Updated programmable control boards will require pairing the Bluetooth connection. Please refer 

to the SpeedCheck user manual at support.carmanah.com for more information. 

6. The default password for all systems starting 2023 Q1 is “speedcheck”. 

 

 
 

Serial Connection Setup (Cable) 

The wired serial option allows the system to be connected using a custom supplied cable from Carmanah. The 

cable features an RS-232 serial connector that plugs into a PC supporting this port. Most modern PC’s typically 

do not feature a serial port so a serial-to-USB adapter would be required instead. 

1. Connect the serial cable to the PC. 

2. Open SpeedCheck Manager. 

3. Click on the Cable radio button, if it is not already selected. 

4. Select the applicable available port. 

5. If you are unsure which port to use, you can reference the Windows Device Manager applet to confirm 

which port number has been assigned by Windows. 

6. Click on Establish Connection. 

7. SpeedCheck Manager should now reflect that it is connected to the system.  

mailto:customersupport@carmanah.com
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Remote Connection Setup (Network) 

The remote connection option utilizes a cellular modem or serial-to-Ethernet converter (with Internet access) to 

connect to individual systems without leaving your office as if you were on site using the Bluetooth or serial 

option. 

This option requires a cellular modem or serial-to-Ethernet converter installed at each system with a dedicated IP 

address and an Internet connection on the PC which will program the system remotely via SpeedCheck Manager. 

The system must be in an area with cellular coverage to send and receive data for the cellular option. 

Resources required: 

• SpeedCheck system 

• Active cellular modem with a known dedicated IP address or DNS; or serial-to-Ethernet converter 

• Windows based PC with SpeedCheck Manager and Internet connectivity 

Each modem has a unique IP address. The Device ID as set in SpeedCheck Manager must also be unique and 

descriptive so you can identify each system. 

1. The cellular modem must be activated and configured with a valid dedicated IP address. Make sure the 

sign is powered on for at least two minutes before trying to connect. 

2. Open SpeedCheck Manager. 

3. Click on the Network radio button, if it is not already selected. 

4. Click on Network Connection Setup. 

5. Click on Add Entry. 

6. Enter the IP address of the cellular modem. 

7. If a password has been established for this particular system enter the password under Device Password. 

8. Click on Test Connection. A successful connection will respond with “Remote System has responded with 

XXXXXX (name of system)”. 

9. Click Add to List to add the system. 

10. Repeat this process for all other cellular-based systems. 

 

Add, edit, or delete additional entries via the Network Connection Setup screen. 

mailto:customersupport@carmanah.com
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Connecting to a Cellular or Networked System  

Once on the Network Connection Setup screen, choose the system you wish to connect to and click the Connect 

button. Alternatively, you can connect directly from the System tab and choose from a system under the Available 

Devices drop-down menu. 

 

All Networked Devices 

You can quickly view all of the networked systems that have been entered via the following sequence: 

• System tab → Verify Device Settings section → All Network Devices 

 

This will attempt to connect to each system in your list. Once connected, each system will be populated with the 

current status for each column. Right-clicking on one of the columns will give you the ability to further choose 

which columns to display. 

 

mailto:customersupport@carmanah.com
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2.5 Device System Controls 

• Set Time & ID – Allows you to enter a name for the sign location and set the internal date and time. The 

ID field allows for up to 24 alphanumeric characters. Be as specific as possible to distinguish between 

other signs nearby and when connecting remotely. 

• Run Test Sequence – Initiates a display digit roll-up test (displaying in succession the numbers 01, 12, 

23, 34, etc.) to test the operation, correct position, and connection of both the left and right display 

boards. 

• Update Firmware – The SpeedCheck Manager comes packaged with the latest version of firmware 

available at the time when it is downloaded/installed. This feature allows you to update individual signs to 

the latest firmware version.  

o It is not recommended to update legacy systems running firmware version 3.47 or older to the 

latest firmware. A new hardware revision in 2021, known as the updated programmable control 

board, requires a firmware version (starting with 10.05) that is not compatible on older versions of 

hardware. Contact Carmanah for more information. 

• Get Device Event Log – Opens a menu to show historical system logs. 

• Reset Device – Performs a soft reset on the system and runs the test sequence. Wait for the system to 

completely reset before communicating with it. This can take up to 60 seconds. 

• Set MPH/KPH – Used for the following scenarios: 

o Legacy programmable controller – uses current radar programming or converts the incoming data 

from the radar to mph or kph. This is only to be used for systems that may be inadvertently set to 

the incorrect unit of speed. It is recommended to leave the setting in Radar Default mode, 

otherwise the system may report inaccurate speeds. 

o Updated programable controller – selects the appropriate unit of speed. Choose the correct unit 

based on your installation location. The updated programmable controller is easily identified as 

they do not require coin cell batteries. See page 12 for a visual representation. 

Set Time & ID 

The Set Time & ID screen allows naming of the system location (24 alphanumeric characters), and internal 

clock/calendar. Adjusting the time may reset the data collection memory. If data collection is enabled, it is advised 

to download the current data first before adjusting the system date/time. Set the Device ID string to a 

recognizable name such as an intersection or landmark for the installation for later identification. For example, 

“2nd and Main St.” or “North Park Elementary NB”.  

Time Reference will only show if you have the GPS “TimeKeeper” option installed. This button performs a time 

reference test via the GPS which takes up to two minutes. 

 

mailto:customersupport@carmanah.com
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Update Firmware 

SpeedCheck Manager will automatically navigate to the folder with the latest firmware available, based on the 

software version. This means that newer versions of software may contain newer releases of firmware. The 

software looks for any .hex files available to use and will display accordingly. 

Select the appropriate file and click Open and then Upload Firmware. This process can take up to 60 seconds to 

complete. After successfully uploading the new firmware, the sign will perform a soft reset and display roll-up. The 

date and time will need to be reset so it is recommended to download any radar data from the system first. 

Note – if an operating schedule was active at the time of the firmware update process, that schedule will remain 

active. If the Scheduler feature was not in use the operating modes will remain as they were set under the 

Operating Modes tab prior to the firmware update. 

Carmanah cannot guarantee firmware compatibility with legacy hardware. It is not recommended to upgrade any 

firmware version 3.47 or older. 

Updated programmable controllers running firmware version 10.05 or newer are on a new hardware platform and 

are not compatible with legacy firmware versions 4.28 or older. 
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Set MPH/KPH 

SpeedCheck Manager will detect the firmware loaded into the system and restrict your options for this setting 

based on your hardware. 

• Updated Programmable Controller – The controller will read back the current setting within the radar. 

User must select MPH or KPH under Radar Unit Settings for their application. This is normally 

preprogrammed based on your local requirements. This is for versions of the SpeedCheck controller that 

don’t have coin cells but are Bluetooth programmable. Go to support.carmanah.com for more information 

on the difference between controller revisions. 

• Legacy Programmable Controller – Defaults to Radar Default. This means the controller interprets what 

the radar is set to already and passes this data through (no conversion is done). 

o Convert to MPH – the controller will take the data from the radar and apply a conversion to mph. 

o Convert to KPH – the controller will take the data from the radar and apply a conversion to kph. 

 
This feature should be left in Radar Default unless the radar is inadvertently factory programmed to the 

incorrect unit of speed for your application. For example, if you notice that speeds are being detected at a 

much higher number than expected it can be assumed the radar is programmed for a kph application. 

Simply multiply the expected speed by 1.6 to confirm. In this example you can select Convert to MPH to 

rectify the issue.  

 Do not adjust this setting unless you are certain the radar is incorrectly set to the wrong unit of speed. 

    

      
Legacy Programmable Controller Updated Programmable Controller 

mailto:customersupport@carmanah.com
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2.6 Device Setup Tab 

The Device Setup tab is used to gain access to change the basic operating modes. The first time you access this 

tab after opening the software and connecting to the system will require the password “unlock”. 

 

Device Setup After Password Entered 

After entering the password, you will see a screen similar to the one below. The available modes will change 

based on your system type and configuration. 

 

Operating Mode Select Method 

• Continuous – will provide one set of speeds on the Operating Modes tab to control operation of the 

system. The standard operating mode for most systems. 

• Select Via External Input – will provide two sets of speeds on the Operating Modes tab to control 

operation of the system. One set is for normal operation and one set is for when an external input triggers 

the system, such as a time switch for a school zone application. Mode 1 settings are for if the input to the 

system is open (not in use) and Mode 2 settings are for if the input to the system is closed (in use). 

Additional hardware and cabling required for this feature. See Section 2.7. 

• Use Scheduler – this mode is used to create a schedule for when and how the system should function. 

Using this feature will no longer show the Operating Modes tab which will not be used for this application. 

Option will only be available if enabled at the factory by Carmanah. Starting 2020 Q1, this was feature 

was made standard on all orders at no additional charge. 

SLOW DOWN Message 

• Option to turn on or off the Slow Down message after the speed limit has been exceeded. This is based 

on the Slow Down setting in the Scheduler or Operating Modes tab. Option will only be available if 

enabled at the factory by Carmanah for orders that contain LED boards with the slow down message. 

mailto:customersupport@carmanah.com
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Request Factory Password 

• Used to gain a one-time access into advanced factory settings. Contact Carmanah for more information. 

You must be on site with the six-digit date key to provide to Carmanah over the phone. This is required if 

you have a system with the Slow Down option installed but it is not available under the Device Setup tab. 

  

 

Output Function 

• For the A and B auxiliary outputs (flashing beacons, strobe, camera). 

o Off – will turn off the selected output. 

o Continuous – will provide a constant 12VDC signal to the selected output when the 

corresponding output activation speed is reached or exceeded. 

o Flash – will provide a 50% duty cycle 12VDC signal (0.5s on, 0.5s off) to the selected output 

when the corresponding output activation speed is reached or exceeded. 

o Fast – will provide a 12VDC signal which follows the display digit flashing rate to the selected 

output when the corresponding output activation speed is reached or exceeded. 

o Strobe – will provide a 12VDC pulse to activate an external strobe device when the 

corresponding out activation speed is reached or exceeded. 

Sync 

• Used to set Output A and Output B to either alternate or sync (unison) with each other. Option will only be 

available if Output A and B are set to either Flash or Fast. 
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LED Drive Current – User-selectable LED drive current for legacy systems running original LED boards. Contact 

Carmanah for clarification. This needs to be adjusted only if the following conditions are met: 

• SpeedCheck controller is Bluetooth capable but does not have replaceable coin cell batteries (updated 

programmable controller). 

• Serial number of system is 14550 or lower, manufactured in April 2010 or earlier, and contains original 

LED display boards. 

Older legacy systems that meet the conditions above should have the drive current set to 20mA. Newer systems 

contain more efficient LED display boards and can run at a lower intensity (10mA) to achieve the same 

brightness. Running the system at the wrong intensity setting result in a dimmer looking display or higher than 

anticipated power draw. 

 

Violation Alert – Flash Rate (FPM) 

• User selectable flash rate for the display digits. Default is set to 109 flashes per minute (fpm) which is 

triggered when the violation alert speed threshold has been met or exceeded. The valid range is between 

30-150 fpm. The sign does not vary the flash rate as speed increases or decreases while above the 

violation alert speed. Requires firmware version 10.05 or later and the updated programmable control 

board. See support.carmanah.com for more information on the updated programmable controller. 

Time Zone  

• Select your time zone. Option will only be available if the GPS TimeKeeper option was purchased. Output 

Function B (flashing beacon) will not be available if the GPS TimeKeeper option is enabled. 

Clock Correction Factor 

• The clock correction factor is used to improve the accuracy of the internal clock. Once per week, at 12:05 

am on Sunday, the sign will apply this correction factor. The clock will always have some error due to 

temperature and other external affects. To determine the correction to apply, determine the amount of 

time gained or lost over the course of a week and add/subtract that amount of time to the current 

correction factor. 

HS (High Speed) Cutoff Function 

• Blank Display – will stop displaying speeds at or above the high speed cutoff value. 

• Display Speed Limit – will display the speed limit at or above the high speed cutoff value. 

• Disable – will continue display speeds up to the maximum value (99). 

Circular Data Collection 

• Prevents the data memory from filling to a point where it stops connecting data. When nearly full (98% at 

240,000 data points), the circular data option overwrites the oldest data records. 

mailto:customersupport@carmanah.com
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Password Protection 

• Enables the ability to assign a password to the system. 

• Once this setting has been enabled you will be prompted to enter your selected password. You will then 

require this password each time you connect to the system. A network (cellular/Ethernet) accessed 

system only requires the password be entered the first time a connection is made, if not entered on the 

Network Connection Setup screen. Passwords are case sensitive and can be up to 12 characters long, 

restricted to ASCII codes 0 – 127. 

• If you have forgotten the system password, you can enter an incorrect value five continuous times before 

the option for a Master Password will become available. Contact Carmanah when on site with the date 

that SpeedCheck Manager gives you as per below: 

 

You will then be required to enter a new password for the system once you have gained access using the Master 

Password. 

Test Sequence at Startup 

• Enables the LED display rollup sequence when the sign is first powered on. This feature is helpful to 

confirm the LED segments are coming on properly. 

Press the Apply button once done making all changes to send the update to the system. 

mailto:customersupport@carmanah.com
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2.7 Operating Modes Tab 

The Operating Modes tab shows various parameters set for system operation. A connection with the system must 

be established to see and change the settings. Some settings are visible only if the appropriate options are 

selected in the Device Setup tab (Section 2.6) or factory programmed by Carmanah. 

This tab will show up to two columns of parameters. If you select Continuous in the Device Setup tab, there will 

only be one column of parameters available. If External Input is selected, a second column of parameters will be 

available. Mode 1 settings are for if the input to the system is open (not in use) and Mode 2 settings are for if the 

input to the system is closed (in use). Additional hardware and cabling required for this feature. If Scheduler is 

selected, the Operating Modes tab will not be available.  

The following parameters can be set from a range of 0-99 (or On/Off): 

Display 

• On or off. 

• For radar-based systems, off will not show speeds on the LED display boards but will still collect vehicle 

speed data. This feature is useful if you wish to collect vehicle speed data without drivers being aware the 

system is in use. 

Data Collection 

• On or off. 

• For radar-based systems, collects vehicle speed data. 

• Must be factory enabled by Carmanah. Starting 2020 Q1 this feature was made standard on all orders at 

no additional charge. 

Speed Limit 

• Sets the speed limit entered into the speed sample data file for later reference. This needs to be set 

whether data collection is used or not. 

Violation Alert Speed 

• Sets the speed at which the LED display boards begin flashing to alert drivers that they are exceeding the 

speed limit. 

SLOW DOWN Speed 

• If installed and enabled, sets the speed at which the Slow Down message is activated. If you enable this 

without the Slow Down option install the LED display boards will flash “88” at and above this speed. 

High Speed Cutoff 

• Sets the maximum speed displayed by the LED display boards. This is recommended to be set to a low 

enough value above the speed limit to discourage drivers using it to detect excessive speeds.  

Minimum Display Speed 

• Sets the minimum speed displayed by the LED display boards. The lowest recommended speed is 5 mph 

or 8 kph. 
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Output A Speed 

• If enabled, sets the speed at which auxiliary Output A is to provide 12VDC for external devices. 

• 0 = always on, 199 = disabled. 

Output B Speed 

• If enabled, sets the speed at which auxiliary Output B is to provide 12VDC for external devices. 

• 0 = always on, 199 = disabled. 

Output A/B – On or Off 

• Turns auxiliary Output A and Output B on or off. 

• For flasher or strobe equipped systems only. 

Mode 1 

• If enabled, these are the parameters when the external input is not activated. 

o For example, when using a time switch this would be the speed settings during non-school 

hours. 

Mode 2 

• If enabled, these are the parameters when the external input is activated. 

o For example, when using a time switch this would be the speed settings during school hours. 

 

 

 
Press the Apply button once done making all changes to send the update to the system. 
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2.8 Data Collection Tab 

The Data Collection tab allows for the following features: 

• System ID naming 

• Current vehicle count report  

• Refresh vehicle count 

o Will update the current vehicle count since the screen was accessed 

• Memory usage report 

• Memory reset 

• Download system data  

This tab will only be available if enabled at the factory by Carmanah. 

The data downloaded from the system will be able to be imported into SpeedCheck Traffic Analyzer for a more in-

depth graphical analysis. See Section 4.0 for more information. 

 

Circular Data Collection (see page 15), when activated, prevents the data memory from filling to a point where it 

stops collecting data. When nearly full (98% at 240,000 data points) the oldest data will begin to be overwritten. 
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Downloading Data 

The process for downloading stored speed data from a sign is the same whether your connection is via Bluetooth, 

serial cable, or network (cellular/Ethernet). Click on the Data Collection tab and then click on Get Data From 

Sign. 

After the data is downloaded you will choose whether to reset your memory or not. 

 
 
The data will be stored into a CSV file saved in this directory (Windows 7 and 10): 

• C:\Users\Public\Documents\Carmanah Technologies\SpeedCheck Manager\Data Files 

Files are automatically named and timestamped for proper identification. 
 

Data Accuracy 

It is important to note that while using radar devices to detect vehicle speeds is very accurate, the use of this 

method for absolute vehicle counting is not recommended. This is simply due to the fact that radar detection 

works by the reflection of high frequency signals off of moving targets. Those targets (vehicles) each have unique 

size, shape, and reflection characteristics. Thus, a small car behind a truck will likely be missed in the count, and 

two like-sized cars travelling close together could be “dithered” – the radar cannot tell which target is measuring at 

that particular time. Occasional missed counts and multiple counts can result in errors in the total. However, the 

speed values will remain accurate, typically within +/- 1mph. For this reason we recommend that the speed 

data can be use as presented, but the vehicle counts should be considered relative in nature and should be 

supplemented by a hard data collection method like a road tube system if vehicle count accuracy is absolutely 

critical.  
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2.9 Scheduler Tab 

This Scheduler tab allows for selection and editing of the following parameters: 

• Operating Modes 

• Daily Timetables 

• Schedules 

• Exceptions 

• Manage Groups 

• Send Schedule 

• Read Schedule  

Unique schedules for each system can be created, managed, and saved for future use using this tab. A nearly 

unlimited number of different schedules can be created in advance without being connected to a system. 

This option will only be available if enabled at the factory by Carmanah and selected as the Operating Mode in the 

Device Setup tab. Starting 2020 Q1 this was feature was made standard on all orders at no additional charge. 

Operating Modes 

• List of speed thresholds at which various options are triggered. 

Daily Timetables 

• Selections of Operating Modes to be used at predetermined times during the day. 

Schedules 

• Weekly programs of Daily Timetables. 

Exceptions 

• Used to amend schedule for holidays, special events, or a range of dates such as school closures. 

Manage Groups 

• Allows for assigning schedules to a group of systems and sending a saved schedule to a system or a 

group of systems via a cellular connection. 

Send All Schedules 

• Used to send schedules selected in Manage Groups to each system listed under the group or subgroup 

using that schedule. 

Get Schedule From Sign 

• Used to download the schedule from a system to confirm what is currently programmed. A TXT file will 

automatically open up with the downloaded schedule. 

  

mailto:customersupport@carmanah.com
https://www.carmanah.com/


   
 

Carmanah Technologies Corp. | 250 Bay St, Victoria, BC V9A 3K5, Canada | 1.250.380.0052 | customersupport@carmanah.com | carmanah.com 22 

SPEEDCHECK MANAGER/TRAFFIC ANALYZER 
CONFIGURATION GUIDE 

 

Send Schedule To Sign 

• Used to send a saved schedule to a system. Connect to the system and return to this screen and click on 

Send Schedule To Sign to choose the correct schedule from the list. 

 

 

 
Making changes to the Operating Modes, Daily Timetables, or Schedules does not automatically send those 

saved changes to a system. After saving changes you will see a message reminding you to connect to the system 

and then send the changed schedule. 
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Edit Operating Modes 

You may configure nearly an unlimited number of Operating Modes. Each mode can be programmed with your 

choice of settings depending on the options purchased and selections in the Device Setup tab. Certain options 

not selected will have an impact on what is available to select. Click Add Mode to create a new operating mode. 

Right-click on a mode name to rename, copy, or delete the mode. The All Off mode is available by default for 

your convenience; it cannot be renamed, copied, or deleted. 

Each mode created must identify the Device Type: 

• Your Speed: the most common system. Displays the speed reported by the radar with an optional slow 

down message. 

• Advisory: displays the speed limit as a static number (radar disabled). 

• Advisory – SLOW DOWN: displays the speed limit as a static number with slow down message when 

the speed limit is exceeded (radar enabled). 

• Flasher: flashing beacon system only (radar optional). 

• DC-FB: Device Controller-Flashing Beacon, external time switch and flasher controller for beacons. 

 

Any selected mode can be duplicated to make entering similar modes easier. Remember to rename the 

duplicated mode with a unique name. Check all settings carefully. 

Since Operating Modes, Timetables, and Schedules are all intertwined, deleting or renaming a mode that is used 

in a timetable will cause that timetable to not work. 
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Refer to Section 2.7 for a description of the different Operating Modes parameters. 

 

Remember, you must click the Save Changes button before proceeding to the next screen. 

Edit Daily Timetables 

You may configure nearly an unlimited number of Daily Timetables based on single or multiple start and stop 

times. Each of the timetables can be set to a previously defined Operating Mode to control operation of the 

display. 

Timetables should be named to make them easily identifiable. To create a new timetable, click on the Add button. 

 

To enter or change a time, click on the Time drop-down menu and a clock window will pop up. Enter the time 

required, AM or PM, and click Save. The associated numbers can be clicked on or the time can be manually 

entered in the text box. 
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To rename, duplicate, or delete a timetable, right-click on the name or choose the menu option. The All Off 

timetable may not be renamed, copied, or deleted. Reset a selected timetable by click on the Reset button. 

Since Operating Modes, Timetables, and Schedules are all intertwined, deleting or rename a mode that is used in 

a timetable will cause that timetable not to work. 

 

These sample timetables illustrate different mode changes: 
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One sample would be the sign uses the following modes: 

• 12:01 AM to 8:40 AM – No School 40 MPH 

• 8:40 AM to 9:40 AM – School Hrs. 15 MPH 

• 9:40 AM to 12:10 PM – No School 40 MPH 

• 12:10 PM to 1:10 PM – School Hrs. 15 MPH 

• 1:10 PM to Midnight (12:00 AM) – No School 40 MPH 

This system will run the normal non-school hours settings at all times other than the specific start and dismissal 

time periods. 

All timetables automatically start with 12:01 AM and end with midnight (12:00 AM). 

 

Another sample is the sign uses the following mode: 

• 12:01 AM to Midnight (12:00 AM) – No School 40 MPH 

This system will run the normal non-school hours settings at all times. This can be used for a weekend, holiday, or 

any other non-scheduled school day. You can also restrict specific times you would not want the system 

(radar/beacons) to be operational on these particular days. 

Remember, you must click the Save Changes button before proceeding to the next screen. 
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Edit Schedules 

You may configure nearly an unlimited number of Schedules, and each can be set to run any of the previously 

defined timetables on any of the seven days of the week. Exceptions are an additional way to attach non-

recurring events. 

Each week is identical and any of the predefined timetables may be selected to run on any day of the week. 

To create a new schedule, click on the Add Schedule button. 

Enter a name that will clearly identify the schedule you are creating as this is the name you will see when 

selecting a complete schedule to send to a sign. Right-click on a schedule name to rename, copy, delete, or use 

the menu options at the bottom of the screen. 

Use the drop-down menu to choose a timetable for each day of the week. The timetable chosen for Monday 

automatically populates this for each weekday. You can select a different timetable for each day of the week as 

required. The timetable chose for Saturday will then be populated for Sunday as well. 

 

In the above sample the weekdays use the timetable Main St. Elementary and the weekend uses No School Day. 
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Adding Exceptions 

The Exceptions list is an additional way to attach non-recurring event days, such as holidays, to selected 

schedules using a different operating mode or timetable. Since a single exception date will likely be used in 

multiple schedules (i.e. Veterans Day), exception lists can be created and then added to the schedules that they 

apply to. 

There are two ways to create or access exceptions: 

1. When creating a schedule (Edit Schedule) – click on the Add button in the Exceptions box. The 

exceptions created will apply to the current schedule. 

 

2. When creating an exception (Edit Exceptions). 
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Creating an Exception List 

1. Click the Add New List button and name it appropriately (i.e. Holidays). 

2. Click the Create New button and use the calendar to select your date range. Then choose a timetable 

from the drop-down menu. 

3. Continue adding any additional dates or events as required. Additional lists can be created as well to 

segregate the event types. Any list can be copied to help make new lists faster to create. 

 

Add Exceptions to a Schedule 

1. Select the exception date(s) you wish to add to a schedule. You can CTRL + left-click or SHIFT + left-click 

to select multiple dates. 

2. Choose the correct schedule from the drop-down menu of available schedules. 

3. Add the exceptions by using the Add Selected or Add All buttons. 

4. Click Save & Exit. 
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Delete Expired will delete any exception that has expired as of the current date. 

Deleted Selected will delete only the exceptions highlighted. 

Change allows individual or multiple exceptions to be changed. Individual allows changes of date and daily 

timetable. Multiple allows only changes to the daily timetable. 

Save & Exit will save the schedule and exception selections you have made and return to the Scheduler tab. 

The Operating Mode, Timetable, and Schedule selections are saved in SpeedCheck Manager for later 

uploading to your SpeedCheck system. 

Send Schedule To Sign 

Once you have completed entering in your operating mode(s), timetable(s), schedule(s), and applicable 

exception(s), you are ready to upload the schedule to your SpeedCheck system. 

1. Connect to the system in SpeedCheck Manager. 

2. Select the Scheduler tab. 

3. Selected Send Schedule To Sign. 

4. Choose from the appropriate schedule. 

 

Because each schedule is comprised of multiple components (operating modes, timetables, schedules, 

exceptions), carefully plan, name, and check each schedule before uploading to each system. Once the schedule 

has been sent you will see the status change at the bottom of the window. Confirm it states the schedule was sent 

successfully. 
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Get Schedule From Sign 

When connected to a system operating a schedule, you can download the schedule information already loaded 

into the system. The downloaded schedule can be saved as a text file or webpage for future reference. 

 

Manage Groups 

The Manage Groups tool requires Internet access and an active cellular modem in each SpeedCheck system. 

Manage Groups is used to send schedule information to multiple systems. If you have a large number of systems 

with the same schedule, then using this tool will save you time. Each system must first be individually set up with 

an IP address, device ID, current time and date, and other user defined functions. Depending on how many 

systems you have, it may be easier to send schedules one at a time to each system. 

Before using Manage Groups you must do the following: 

1. Connect to each system and then add them to the Network Connection Entry list (see Section 2.4). 

2. Create modes, timetables, and schedules for the system. 

3. Determine which systems can operate on the same schedule as this will become your group. 

The process of Manage Groups is as follows: 

1. Delete any unused groups (i.e. flashers). 

2. Create major groups by system type (right-click for menu). 

3. Create sub-groups for all systems that will be using the same schedule. 

4. Add the schedule which the group of systems will use. 

5. Add the systems to the group. 

6. Click Send All Schedules to send the selected schedule to all systems assigned to the group. 

Clicking on Manage Groups will display the common system types as groups: 

• Changeable Speed Limit (Variable Speed Limit) 

• Driver Feedback (SpeedCheck, most common) 

• Flashers (beacons) 
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Right-click on the system type that you are not using and delete. Once unused groups are deleted, right-click on 

the system and rename as required (i.e. School Zones). Right-click and choose Add Group, select the system 

type, then assign the group a name. The best way to organize your systems is to group all similar ones together. 

Sub-groups can be used to organize systems into unique groups. All systems under a sub-group will use the 

same schedule. 

 

Using schools as an example, many schools would most likely have the same school hours so they could share 

the same timetables. All systems in a group must use the same schedule. You can have multiple sub-groups as 

required that use different schedules. Rather than send schedules to signs one at a time, Manage Groups will 

send the selected schedule to all signs listed under that subgroup schedule. 

Send All Schedules 

This command will send the schedules selected in Manage Groups to each sign listed under the group or sub-

group using that schedule. Options for sending schedules are select all signs, select by schedule, or click on 

individual signs. 

The Send All Schedules will automatically connect to each system and do the following: 

1. Send the appropriate schedule. 

2. Disconnect from the system. 

3. Repeat the process for all remaining systems in the Network Connection Setup screen. 

Passwords are not required for each system when using Send All Schedules, since the passwords are stored in 

the Network Connection Setup data. 
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3.0 SPEEDCHECK-12 Specific Features & Settings 

SPEEDCHECK-12 has support for the mobile app and PC versions of SpeedCheck Manager. There are four 

main functions of the PC software version that are not currently supported by the mobile app: 

• Changing the Operating Mode (Continuous or Scheduler) 

• Creating and uploading schedules  

• Retrieving vehicle speed data 

• Evaluating vehicle speed data with SpeedCheck Traffic Analyzer (bundled with PC version of 

SpeedCheck Manager) 

 

 
 

SpeedCheck Manager will detect when you’re connected to a SPEEDCHECK-12 sign and will expose and restrict 

certain applicable features and settings. The primary feature additions are as follows: 

 

• System Status (System tab) 

• Strobe On/Off (Operating Modes & Scheduler tabs) 

• Strobe Speed (Operating Modes & Scheduler tabs) 

 

Other features applicable to SPEEDCHECK-15/18 systems will either be grayed out or no longer exposed when 

connected to a SPEEDCHECK-12 system. 

 

 

  

 

SpeedCheck Manager (PC) version 3.0.2.3 or newer is required for operation with 
SPEEDCHECK-12 radar speed signs. Starting with this release all models (SPEEDCHECK- 
12/15/18) are supported. Download the latest version at support.carmanah.com. 

 
SPEEDCHECK-12 firmware versions are different than SPEEDCHECK-15/18 and are not 
interchangeable.  

  

 
SpeedCheck Manager mobile is available free of charge on the Apple App Store and Google 
Play Store for compatible devices.  
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4.0 SpeedCheck Traffic Analyzer 

4.1 Introduction 

SpeedCheck Traffic Analyzer allows viewing, manipulation, charting, and printing of speed data downloaded from 

radar enabled SpeedCheck systems. The data is a useful tool in studying speed problems, speed reduction 

programs, or speed trends over time. SpeedCheck Traffic Analyzer is a standalone program that provides 

charting, statistical analysis, combining of data files, windowing data to particular days or hours of operation, and 

removal of speed data outside the areas of study. 

Refer to Section 2.8 to download the data for the system you are looking to analyze. 

To view your data, open SpeedCheck Traffic Analyzer. Once open the application will automatically look for saved 

data files via SpeedCheck Manager. The directory these files are location is as follows: 

• Windows 7 & 10 – C:\Users\Public\Public Documents\SpeedCheck\Data Files  

Select the data file you wish to analyze and click Open. 
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4.2 Operation 

Compliance 

The bar chart will show vehicles that are: 

• Above the posted speed limit plus excessive speeding (red bar). 

• At or below posted speed limit plus excessive speeding (orange bar). 

• At or below posted speed limit plus minor speeding (yellow bar). 

• At or below the posted speed limit (green bar). 

The posted speed limit, minor speeding, and major speeding thresholds can all be changed to suit your specific 

needs. This is covered in the Chart Options menu. 

 

• Number of data points – numerical value of data points collected by SpeedCheck Manager. Refer to 

Section 2.8 regarding data accuracy. 

• Average daily volume – the average daily volume based on the total number of data points and 

database range. 

• Posted speed – the speed limit as set in Chart Options. 

• Average speed – the average speed across all data points. 

• Percentiles – the default percentiles are 85th and 50th: 

o 85th percentile – the speed at or below which 85% of the data points collected fall under. 

o 50th percentile – the median speed; half of the data points collected are below this value and half 

of the data points collected are above. 

View Charts 

Provides a scatter plot chart of the raw data imported from SpeedCheck Manager. The entire range of the data 

will be displayed initially, but this can be filtered out further under the Options menu to suit your specific needs. 

View Data 

Provides a spreadsheet style view of the raw data imported from SpeedCheck Manager. The entire range of the 

data will be displayed initially, but this can be filtered out further under the Options menu to suit your specific 

needs. 
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Chart Options 

Speed Axis Scale Parameters 

Sets the parameters for the vertical axis of the graph. Uncheck Use Default Scale to input your own parameters. 

Chart Display Options 

• Chart Points – is used to turn on or off the display of individual data points. Leaving the default setting of 

Chart Points unchecked results in faster screen drawing, faster viewing of only the moving average and 

statistical quantities without displaying the data. 

• Chart Moving Average – is used to enable the moving average line which shows the average of the 

most recent data points. The number value input here will set the number of data points used for the 

moving average. More points will provide an average over a longer time frame, whereas fewer provides 

will provide a line that follows the individual data points more closely. If no number is input here, the chart 

will use a moving average of 10% of the displayed data. 

• Chart Posted Speed – is used to turn on or off the display line that indicates the posted speed limit. The 

number value entered here sets the Posted Speed line. 

• Chart Average – is used to turn on or off the display line that indicates the average of all of the displayed 

points. 

• Percentile – is used to set the display line that indicates the percentage of all of the display points, most 

commonly the 85th percentile. Additional percentile lines can be added by entering the number in the 

spaces provided. Blank entries will not be displayed. 

A moving average is an average of the preceding N-values in the data set. The default N is 50, meaning each 

point on the moving average line is the average of the preceding 50 points. The value of N can be changed in the 

Chart Options menu. 
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Data Selection 

The Data Selection menu allows you to change the data start and end points. The dates and times can be 

adjusted to suit your specific needs. 

 

Data Filter 

The Data Filter menu allows you to use the data filtering and windowing options. You may select which days of 

the week to include in the analysis and which hours of the day to include. Optionally you may exclude speeds 

greater than or less than specific thresholds outside your range of interest or exclude speeds that are more than 

one to four standard deviations from the average. The default setting is to remove data points greater than three 

standard deviations from the mean. 

Standard deviation is a statistical term that indicates variability from an average (mean) data level in a particular 

data set. Assuming the data conforms to a bell curve distribution, below is the breakdown of the coverage: 

• One standard deviation on each side of the average will include 68% of all data in the set. 

• Two standard deviations on each side of the average will include 95% of all data in the set. 

• Three standard deviations on each side of the average will include 99.6% of all data in the set. 

• Four standard deviations on each side of the average will include 99.8% of all data in the set. 
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Sample Filtered Data 
 

 

Add Data File 

This will allow you to merge additional data sets into one complete report. You will have three choices on how the 

data gets merged in the case of duplicated data (data points with same timestamp recording the same speed) 

 

Export Data 

This will allow you to export the data (all data or filtered data) into a CSV file. You can also export the current 

View Chart view into a PDF file under File → Export to PDF. 
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5.0 Troubleshooting 

Refer to the SpeedCheck user manual found at support.carmanah.com for more information. 

6.0 File Names 

Software and firmware files used by SpeedCheck Manager include the following: 

• SpeedCheck<xxxx>.hex is the SpeedCheck firmware program that resides in the display sign, controlling 

all functions of the system and any options purchased with it. The SpeedCheck product can be updated 

with this firmware file through SpeedCheck Manager (see Section 2.5). 

• <sign_name> <mm-dd-yy> <hh;mm>.csv is the SpeedCheck vehicle speed data file as it appears on your 

PC after downloading. This file will be saved in: 

o Windows 7, 10 & 11 – C:\Users\Public\Documents\Carmanah Technologies\SpeedCheck 

Manager\Data Files 

The data file name will have a trailing two-digit file number representing the time of day the data files was 

downloaded. For example, “Fifth & Main Sep-26-08 15;44.csv”. 
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Toll Free: 1.877.722.8877 (US & Canada) 
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